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Abstract — Széchenyi István University (SIU) is one of the youngest and extensively developing universities in 
Hungary, situated geographically in an excellent location, near Budapest and Vienna. The university has the second 
largest technical faculty, in Hungary and maintains a good scientific and economic relationships with a wide range of 
leading companies like Audi Hungaria Motor Ltd. Recently, Lifelong Learning (LLL) is going to be connected strongly 
with the notion of e-learning. E-learning becomes more popular and generates great competition between educational 
institutions. The on-line access of web-based learning material is a reality, today. Pedagogical technology including LL 
technologies changes permanently and is determined by several elements, aspects and methods of Information and 
Communication Technology (ICT). More than five years ago, at Széchenyi István University (SIU) the management 
realized that distant education mainly in the Faculty of Engineering Sciences needs modernization. The main goal was to 
raise efficiency and effectiveness of the instruction, in order to cope with the challenges of the engineering labor market. 
One of the solutions was the introduction of e-learning methods. This happened in the education of the Institute of 
Electrical and Mechanical Engineering, for the first time. Inquiries have shown that more than two-thirds of the part 
time students prefer e-learning courses as a result the application of this most up-to-date method has been accelerated. 
Széchenyi István University is one of the most active members of the MELLearN Network (Hungarian University Lifelong 
Learning Network) organizing work-shops and conferences providing opportunities to examine non-formal and informal 
channels in lifelong learning. However, this paper will show how students can be prepared for the application of future 
lifelong learning technologies, in our graduate (formal) higher education. 
 

Index Terms — attitude, e-learning, lifelong learning, preparation  

 
INTRODUCTION 
 
Széchenyi István University (SIU) introduced e-learning based distance education in autumn 2004 firstly in Hungary for 
transport engineers, one year later for economists, and for engineering management students, too. [1] 

Our goal was to introduce e-learning in a wide range of the part time education. We have not only started an 
experiment with few students – as they did at some other Hungarian universities – but we wanted to have the majority of 
our distant learning students learn from the beginning until their graduation using the most advanced lifelong learning 
technology, the e-learning. 

The training is based on the ‘COEDU’ e-learning system shell of Mimoza Communications Ltd. Curriculum 
development is based on their ‘COEDITOR’ software. The members of the curriculum development team are the 
instructors of the Department of Technical Teacher Training.  

The curriculum has been designed for online use, but learning materials are reachable via CD-ROM or are 
downloadable in PDF format [2]. The personal preparation of students is assisted with so called ‘Study Schedules’. 
According to our experiences, learning results are better than traditional distance learning. 

 
CAMPUS NETWORK ARCHITECTURE 

 
At the University a high level of IT infrastructure is available: Ethernet LAN 100 Mb/s, and proper server resources for 
web-based e-learning solutions. (see Fig. 1) 

We have realized that a reliable, robust and powerful computer network infrastructure is inevitable, so we have built 
an advanced Cisco solution for the on-line Internet/Intranet access. Necessary safety measures have been put in place in 
order to provide uninterrupted, safe operation of the whole system. 
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FIGURE 1 

CAMPUS NETWORK ARCHITECTURE 
 

SELECTION OF AN E-LEARNING FRAMEWORK 
 
We have examined the “big names” (WebCT, Learning Space, iLearning etc.), but we have faced problems such as: 
• heavy HW/SW requirements, 
• customizing into Hungarian (language and education system) is a difficult task, and/or can only be partially 

completed, 
• only “upper” level, “general” support is offered, 
• relatively expensive products for an educational institute. 

 
In addition, under the actual application a huge, robust basic-SW system must run, and this raises the operating 

expenses. 
 
In finding the optimal solution, we have declared some crucial requirements: 

• opportunity to influence the requirement specification and functionality (in between development), 
• direct (“personal”) help-desk, quick response, intensive support and training at the introduction phase, 
• reasonable price for licenses and for the yearly support and help-desk. 

 
We have examined some Hungarian products and finally, we have chosen the COEDU system of the Mimoza Ltd. 
 

THE STRUCTURE OF THE COEDU SYSTEM 
 
COEDU system is the most frequently used distance learning application in Hungary; it is practically used in all public 
education, higher education and adult education. 

 
The COEDU system has four parts (see Fig.2):  
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FIGURE 2 
THE STRUCTURE OF THE COEDU SYSTEM 

• The course management subsystem 
• The course administration subsystem 
• The course editor subsystem (COEDITOR) 
• The course displayer subsystem 

 
With the course editor we can make XML-based e-learning curricula. The editor is capable of generating SCORM 

1.2 compatible courses. Courses are built from modules, and modules are divided into lessons. 
In the COEDU system there are the following authorizations: 

• system administrator 
• curriculum developer 
• study administrator 
• tutor 
• student 

 
The system administrator has the most general authorizations. He can define user groups, can give them predefined 

authorizations and can handle courses under construction. 
A curriculum developer can generate an empty course, can clone and rename a course. A curriculum developer is 

able to test courses, which are not reachable for students. A curriculum developer can download an empty course from 
the server, and can fill it with subject matter. He can upload the ready course to the server. A curriculum developer can 
generate the PDF and the offline version of the course. The PDF version is for students who prefer printable subject 
matter; the offline version also helps in the case of a slow Internet connection. 

A study administrator can manage student groups. He gives the startup and expiration date of a course, and he can 
give a tutor for a student group. 

Tutors can send messages to students. They can observe the studies of students, because the tests at the end of a 
module are logged in the system. The tests at the end of a lesson are not logged; their purpose is for self evaluation. 
Tutors are evaluating the answers to open-ended test questions, too. The answers to other test question types are 
evaluated automatically by the learning management system (LMS). 

Students can study online or offline. They can use the built-in Forum of the COEDU system to chat with each other, 
or they can send personal messages in e-mail to the tutor. The chat Forum service is broadly used to talk over study 
problems. 

 
THE COEDU COURSE EDITOR 
 
In the Course Editor, the curriculum developers can select English, Hungarian and Russian language. The File menu of 
the Course Editor has the usual functions (see Fig. 3). Developers can open, download, upload, and save courses. They 
can migrate to another server, work offline, and export the course in SCORM 1.2 and Oracle format. The Edit menu has a 
refresh and an undo function. The Options menu gives possibilities to set the server, the language, the proxy, etc. The 
Help menu gives information about the version number of the editor. 

 

 
 

FIGURE 3 
THE FILE MENU OF THE COURSE EDITOR 
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As we have mentioned before, the Course Editor is XML based. It stores lessons in separate XML files, and the 

course has a common XML file listing the lessons of the course. All courses are stored in separate folders. 
The language of the courses is selectable.  
Math formulas can be written with a simple integrated editor. Formulas can be inserted in JPEG and MathML 

format. Formulas can be copied from the editor to the clipboard, and from the clipboard the MathML code can be pasted 
as a formula to the Course Editor.  

Of course we can insert images, animations and videos to the lessons. These multimedia elements have key roles: 
they have their own didactical function and demonstrate the newest technological solutions that are necessary for the 
student to know. In their future life, concerning lifelong learning technologies they will meet similar technologies. It is 
inevitable to aid the development of their attitude in connection with the newest technologies emerging continuously.  

We can use normal images, zoom images, flipbooks (a predefined chain of images), and timelines too. The subject 
matter has three selectable representations (contracted, normal and enriched) according to the current needs of the 
student. 

The working surface of the Course Editor is shown in Fig. 4. 
 

 
FIGURE 4 

THE WORKING SURFACE OF THE COURSE EDITOR 
 

The upper left frame is the editor tree. The developer can insert to the tree modules, lessons or parts of a lesson. The 
middle left frame shows the selectable parts of the lesson. The lower right frame offers the selectable languages. The 
upper right frame is the visible part of the lesson, as is. The lower right frame is the input text window, if it is active. 

 
VISUAL ELEMENTS IN THE COEDU SYSTEM 
 
Visual elements are playing an important role in understanding the subject matter. We can import visual elements as 
external files to the system. It means that we have to prepare them outside the system using another application. 

A picture is the simplest visual element. A zoom picture is composed of two images, one is a normal image and the 
other is a big image, which by mouse click opens in a pop-up window. 

The viewer picture consists of a big image field and at the bottom of it more little images. Moving the mouse cursor 
upon a little image, we can see a big pair of the image. 

A flipbook is a great means for providing interactivity that serves for better understanding of a process. It is 
composed of more picture elements; these can be controlled by the user in succession by means of an arrow button (see 
Fig. 5). 

A timeline is similar to the flipbook; with it we can present a temporal process (we have to associate every picture 
element in a moment). 

The inline picture is a small image; it is used to insert a Greek letter, an icon or a button of some software. 
Flash and video objects are used to join interactive images, simulations, small films, and cartoons related to the 

content matter. The system starts the default media player on the computer of the user, and presents the file. After 
viewing the user has to close the window of the media player. 
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FIGURE 5 

A FLIPBOOK 
 

CURRICULUM DEVELOPMENT 
 
In course design we start out with existing lecture notes, textbooks and course syllabuses. We analyze the requirements 
of the course, and explore the existing paper-based midterm and exam tests. Relying upon these findings we determine 
the detailed requirement system of individual subjects. The detailed requirement system forms the basis of preparing 
electronic curricula and study guides. 

We prepare a study guide if an up-to-date standard textbook is available. If a textbook is outdated, or is not available 
then we prepare a complete electronic curriculum. In this case, the need for students to use an additional printed textbook 
is not necessary. 

We have developed a ‘study guide booklet’ with a unified structure. We divide the course to modules, and the 
modules to lessons. The modules are corresponding to the ‘classical’ chapters. The lessons are logic units; the extent of 
the lesson is such, that a student can study it during one, or one and a half hours. The lesson begins with learning 
objectives, the next part is the methodological guidance for student activities, and the third part is the summary. At the 
end of every lesson there is a test for self-evaluation. This test is not scored, so it is possible to retake it more times, in the 
online mode. The solutions of the tests are not logged into the system. 

The lessons of a ‘real’ electronic curriculum differ from the lessons of those with study guides. They do not refer to 
the pages of a printed textbook, because they contain the whole subject matter (text and multimedia). So the lessons of 
the real electronic curricula generally do not contain a separated summary. 

At the end of the individual modules there are scored closing tests, so they can be solved only once. The scores are 
logged into the system, so the tutor can trace the progress of students. 

The tutor can determine from the student records which parts of the curriculum cause difficulties in the subject. The 
module closing tests are similar to the exam tests; with this we want to help in the preparation of students for the exams. 

Curriculum development is made in group work. The members of the Curriculum Development Group are generally 
the instructors of the Department of Technical Teacher Training. In the development of the study guide of a subject the 
participants include the instructor responsible for the subject (who is selected by the department responsible for the 
instruction of the subject), the curriculum developer and the digitizer. 

The digitizer converts the course written in Word format to the COEDU XML based format. Our digitizer has 
developed conversion software for the sake of quick work. The digitizer is an informatics engineer. Of course, some 
developers are working with the Course Editor, so the conversion mentioned before is not always necessary. 

The cooperation of the team described before is based on a well-defined division of tasks. The curriculum is 
compiled by the developer in accordance with the lesson-closing and the module-closing tests. The instructor responsible 
for the subject revises the curriculum. The compilation of the tests for the exams on the basis of the detailed requirements 
is the task of the instructor responsible for the subject, and is the competence of the given professional department 

International Conference on Engineering Education ICEE-2010 July  18–22, 2010, Gliwice, Poland. 
5 



The special circumstances of e-learning based distance education necessitate the preparation of students for the use 
of the new tools. In the first semester they have a special subject named Proseminarium. This subject introduces them to 
the new lifelong learning technology, and instructs them on how to use the features of the COEDU system. They have 
practical tasks to solve: they have to fill out the module closing tests of the course, they have to send e-mails to the tutor, 
and they have to send messages to the chat Forum. 
 
ON-LINE EXAMINATIONS 
 
Students have to take exams under strict controls. For security reasons it is possible to take an examination only on 
dedicated computers in special computer rooms of the university. Students solve the exam tests presented by the 
computer system. In the case of automatic scoring, students can view their score at the end of the exam. If tutors score the 
tests involving open-ended questions then the results are known within one day. 

The test server is a dedicated server; it does not serve other purposes. Of course there is a server for the sake of 
security (back-up purposes), too. 

Tutors can reach the test server only via secure method. They use the Cisco VPN client to see the tests of the 
students. Test scores are converted to grades in a predefined manner. Recently, there is no direct connection between 
COEDU and the older university student management system, so tutors have to enter in the grades manually. Students 
can query their grades from the computer system using an Internet or Intranet connection. We plan to avoid this 
inconvenience by establishing an application program interface (API) between the two systems. 

 
QUALITY MANAGEMENT 
 
To improve the quality of instruction we use three methods:  
• The system administrator regularly (once a month) prepares a digest of the most interesting student comments from 

the chat Forum. Students are very critical when they are writing experiences about the training process to each other. 
These digests are sent regularly to the leaders of the university. 

• The tutors are collecting the comments of students sent by e-mails. These comments are discussed at the conferences 
of tutors in every semester. 

• Once a year, the head tutor collects the opinions of students in the form of an anonymous online questionnaire. The 
data is analyzed and sent to the leaders of the university. 
 
Of course, we used to talk with students occasionally and at the beginning of each semester. The leader of Adult 

Training Center regularly holds open hours, and collects observations and comments made by the students. 
The data of student satisfaction is the basis of ordinations of the leaders of the university to improve the quality of 

instruction. 

RESULTS AND PERSPECTIVES 
 
In practice, the Faculty of Engineering Sciences of the SIU is the second largest technical faculty in Hungary. The 
management of the university recognized the necessity of the introduction of e-learning in its distance education, in time, 
so until this time 719 students have graduated and have got degrees purely supported by e-learning courses and exams. 
We are still in a leading position concerning the application of e-learning, in Hungary. In this semester, at four faculties 
more than 1200 student choose the “e-way”. We plan to include e-learning courses into the curriculum of the doctoral 
school of the Engineering Faculty [3].  

These days, we are introducing the next generation Moodle LMS system and integrating Web-2 solutions into our 
virtual learning environment. We proudly announce that the BsC course in Transportation Engineering is the only one e-
learning-based course, in Hungary, as of today. 

E-learning, this new lifelong learning strategy gives the opportunity for our students to become acquainted with the 
newest method of pedagogical technology and shapes their attitude in being more open to new communication and 
technological changes. 

E-learning courses attract more and more students at SIU. Although, in the part time education the spreading of e-
learning is the most common, more and more full time students are showing interest in e-learning courses. 

Recently, SIU has won applications and has funds for developing e-learning material for the BsC and MsC courses 
in other institutes and departments of the faculty, as well [4]. These materials to be developed allow the introduction of 
‘blended learning’ that will raise the efficiency of the instruction [5]. Blended learning as a new pedagogical technology 
can prepare students for typical lifelong learning situations: during their life, in non-formal and informal educational 
situations they can make good use of the knowledge and attitudes gained during their university studies. 
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